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Cytoscapeとは？

Cytoscape1)は，遺伝子，タンパク質，化合物などを
構成要素とするパスウェイ，ネットワークデータを可視
化，統合，解析するためのオープンソースのソフトウェ
アである．開発がスタートして約15年が経過するが，
現在も精力的にバージョンアップが行われており，長き
にわたりライフサイエンス分野のパスウェイ，ネット
ワークデータの可視化，解析ツールのデファクト・スタ
ンダードとしての地位を確立している．Cytoscapeの
Webサイト 2)から，Mac，Windows，Linuxの各OSのバー
ジョンが提供されており，ライセンスを確認，同意すれ
ば，誰でも自由にダウンロードして使うことができる．
数万の構成要素からなる巨大かつ複雑なパスウェイ，

ネットワークを取り扱うことが可能であり，ライフサイ
エンスデータだけではなく，さまざまの分野のパスウェ
イ，ネットワークデータの可視化，統合，解析に使用さ
れている実績がある．上記に加え，Cytoscapeの特徴と
機能は次のように整理される．
・GML，BioPAX，PSI-MI，KGML，SBMLなどさま
ざまな標準化データ（フォーマット）に対応

・Pathway Commons，IntAct，BioMartなど外部の公的
データベースからのデータインポート

・Igraph，Bioconductorなどとのデータ相互運用を確保
・データの編集，解析履歴を残すセッションファイルの
取扱い

・柔軟なデータ可視化機能
・PDF，PS，SVG，PNG，JPEGなどの各種画像デー
タ形式の出力

・豊富なパスウェイの自動レイアウト
・パスウェイの構成要素に対する検索機能
・ブラウジング機能
・フィルタリング（絞り込み）機能
・部分パスウェイ，モジュール構造の抽出，発見
・アプリ（Apps）による機能追加（データ解析など）
・多言語対応
中でも自動レイアウトは，巨大なパスウェイ，ネット

ワークに対する視認性と理解を深めるうえで，有効かつ
強力な機能である．
なお，本稿ではパスウェイとネットワークの厳密な区

別をしていない．グラフ要素（ノード（点）とエッジ（線））
で構成される遺伝子，タンパク質，化合物などの生体内
外の分子や生物学的イベント間の相互作用の集合をパス

ウェイもしくはネットワークとして取り扱っている．ま
た，本稿は2017年1月25日時点の最新バージョンであ
るCytoscape 3.4.0を対象に作成した．

Cytoscapeで何ができるか？そのメリットは？

たとえば，マイクロアレイやRNA-seqなど網羅的遺
伝子発現解析によって得られた膨大な遺伝子別の発現量
データを表形式で整理した場合，せいぜい発現量を昇順
や降順で並べ替えて見比べるぐらいで，そこからデータ
の意味を解釈することはまず不可能である．このような
遺伝子発現データでは，統計学的な手法などを用いて，
処理区間やフェノタイプ間で特異的な発現パターンを示
した遺伝子群（Differentially Expressed Genes: DEGs）
を抽出した後，これを既知のタンパク質－タンパク質相
互作用（PPI）ネットワークや，遺伝子制御ネットワー
ク（GRN）に重ね合わせ，DEGsすなわち遺伝子もし
くはタンパク質をノードとするパスウェイ，ネットワー
クとして可視化することが有効であると考えられる（図
1）．それを可能にするのがCytoscapeである．
ノードの色を遺伝子発現量によって連続的に変化させ
たり，ノード間の関係に有向エッジを用いたりすること
で，ノード間の関係，たとえば単純な正や負の制御関係
であればそれを俯瞰して確認することが可能になる．ま
た，パスウェイ，ネットワークの構造上，重要な役割を
持っていると考えられる他のノードとの接続数が多い
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図1．遺伝子発現データの表形式からネットワークへの可視化
の結果．ノードの大きさは各ノードが持つエッジの数を反映
（エッジ数多い → ノード大），エッジの方向は遺伝子発現制御
の関係を表す．
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ノード，すなわちハブとなるノード（遺伝子，タンパク
質）を見つけることも可能になる．このようにデータを
パスウェイ，ネットワークの形式で可視化することは，
データの解釈を支援し，そのメリットは大きいと考えら
れる．

Cytoscapeでは，単体もしくはアプリを通して，表形
式の遺伝子発現量データを外部の公的データベースが
持つPPIネットワークやGRNの情報を使ってパスウェ
イ，ネットワーク形式に表示するパスウェイ構築機能
（例，Cytoscapeアプリ：stringApp3)，GeneMANIA4)，
WikiPathways5)，ノード間（遺伝子間）制御関係（例，
同：MCDS6)）やハブを発見する機能（例，同：
NetworkAnalyzer7)）などを実装している．これら
Cytoscapeの複雑ネットワークの可視化，解析機能は，
トランスクリプトーム解析だけではなくプロテオーム
などさまざまなタイプの大規模データ解析に活用可能で
ある．

Cytoscapeの基本操作

起動と画面構成　　CytoscapeはCytoscapeフォルダ
の中にあるCytoscape(.exe)から起動する．起動すると
図2のような画面が表示される．①はパスウェイ，ネッ
トワークを表示するメインネットワークビュー，②は
ノードやエッジの属性（遺伝子名，発現量，関係のタイ
プなど）を表示するテーブルパネル，③はノードやエッ
ジの色や形の編集およびパスウェイの含有関係を表示す
るコントロールパネル，④はさまざまな操作を実行する
メインメニューである．
ファイルの読み込み，パスウェイ画像の出力　　デー
タの読み込みは，メインメニュー（図2④）のFileの
Openもしくは Importから行う．Cytoscapeフォルダの
中にsampleDataがあり，その中にgalFiltered.cysがある．
galFiltered.cysは出芽酵母のマイクロアレイ遺伝子発現
量実験の結果をパスウェイ上に反映したデータである．

拡張子cysのファイルは，Cytoscapeで作成したパスウェ
イデータであり，この拡張子のファイルは，Fileの
Openから開く．一方，Microsoftエクセルやテキストエ
ディタなど他のソフトウェアで作成したノードとエッジ
の関係を記述したパスウェイデータ（拡張子xls，sif，
gml，csvなど．例，galFiltered.xls）は，File > Import 
> Network > File…から読み込む．ノードやエッジの属
性情報（発現量など実験データや遺伝子名，PPIなど関
係の種類など）を記述したファイル（例，galExpData.
csv）はFile > Import > Table > File…から読み込む．ノー
ドやエッジの属性情報データを読み込む場合には，どの
カラム（列）をユニークキー（例，Entrez Gene ID）に
するかなどの指定を求めるウィンドウが開く．指定の方
法がわからない場合は，生命科学分野の有用なデータ
ベースやツールの使い方を動画で紹介するウェブサイ
ト，統合TVのコンテンツ「Cytoscapeの使い方～遺伝
子発現を例にしたデータの可視化～」8)も参照されたい．
作成したパスウェイデータはFileのSaveで拡張子cys
ファイルとして保存される．File > Export > Networkも
しくはNetwork and Viewからsif，xgmmlなどの形式で
も保存することが可能である．また，File > Export > 
Network View as GraphicsでPDF，PS，SVG，PNG，
JPEGの各フォーマットで画像データとして保存可能で
ある．
アプリ（Apps）のインストール　　Cytoscapeには，

データ解析，データインポート，可視化など170種類以
上のアプリ（2017年1月25日現在）が用意されており，
ユーザーは必要なアプリをインストールして使用するこ
とができる．最新のネットワーク解析，統計手法，デー
タ分析のアルゴリズムがCytoscapeのアプリとして提
供されることも少なくなく，ユーザーは最先端の解析
技術を使ってデータの解釈を行うことが可能である．ア
プリのインストールは，メインメニューのApps > App 
Managerから行う．インストールしたアプリは，メイン
メニューのAppsから使用するアプリを指定し実行する．
隣接するノードの抽出，部分パスウェイの切出し  
大きなパスウェイから，たとえば，過剰発現など特異的
な遺伝子発現パターンを示した遺伝子（群）（DEGs）
など特定の遺伝子（群）と直接相互作用がある遺伝子（群）
から構成される部分パスウェイ（サブパスウェイ）を抽
出，切り出す手順を紹介する．
まず，コントロールパネル（図2③）のNetworkタブ
で対象とするパスウェイを指定し，そのパスウェイがメ
インネットワークビュー（図2①）で表示されているこ
とを確認する．次に有意差検定やFold Changeなどによっ
て事前に算出しておいたDEGsをメインネットワーク
ビューから直接選択，あるいはテーブルパネル（図2②）
のノードの属性値からDEGsを選択する．DEGsを選択
した状態で，メインメニューのSelect > Nodes > First 
Neighbors of Selected Nodes > Undirectedを選択し，次図2．Cytoscapeの画面構成
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にメインメニューのFile > New > Network > From 
selected nodes, all edgesを選択する．メインネットワー
クビューに目的の部分パスウェイが表示されているはず
である．またコントロールパネルのNetworkタブを見
れば，部分パスウェイと元のパスウェイの関係を確認す
ることができる．
使用メモリの設定とメモリの解放　　Cytoscape

フォルダにあるCytoscape. vmoptionsを編集すること
でCytoscapeが使用するメモリ量を設定することができ
る 9)．Cytoscape. vmoptionsをテキストエディタなどで
開き，Xmxの値を修正すればよい．通常は初期設定の
ままでよいが，取り扱うパスウェイのサイズが大きい
（ノードとエッジ数が多い）場合には，適当な値に書き
換える必要がある（例，4GB）．一方，Cytoscape起動中
のメモリは画面右下のMemoryボタンから解放できる
（図2⑤）．

パスウェイ，ネットワーク解析の実際

ここではCytoscapeの代表的なアプリおよび他の解析
ツール，Webサービスを取り上げ，RNA-seqやマイク
ロアレイを使った遺伝子発現データを用いた最近のパス
ウェイ，ネットワーク解析の事例を紹介する．遺伝子発
現データの典型的な解析プロセスは，1．DEGsの抽出 
→ DEGsの機能予測 → 機能予測結果の可視化，2．
DEGsの抽出 → DEGsを含むパスウェイ，ネットワーク
の作成 → ハブ遺伝子の識別，3．DEGsの抽出 → DEGs
を含むパスウェイ，ネットワークの作成 → 部分パス
ウェイの抽出 → 部分パスウェイの機能予測，となる．
以下，これら各解析の概要とその操作手順を説明する．
なお，ここで取り上げたCytoscapeのアプリやその他

のツールは，解析初級者でも使いやすいこと，国内外で
実際によく使われていることを観点に，筆者の経験と独
自の調査に基づき選んだものである．今回取り上げな
かったアプリ，ツール中にも，さまざまな長所を持った
秀逸なものが存在するが，紙面の都合もあり割愛したこ
とをご理解いただきたい．

1-1．DEGsの抽出　　対照区－処理区間やフェノ
タイプ間のDEGsを抽出するには，Webサービス
NetworkAnalyst10)が解析初級者でも使いやすい．Rを
使えるユーザーには，最新のアルゴリズムを含む豊富な
手法がまとめられているWebページ「（Rで）塩基配列
解析 11)」「（Rで）マイクロアレイデータ解析 12)」を参照
することを薦める．Excelの統計機能や関数を使っても
DEGsは可能だが，t-検定やFold Changeなどの手法に
限定される．

1-2．DEGsの機能予測（Enrichment解析）　　抽出
したDEGsには，Gene Ontology，KEGG，Reactomeな
どのデータベースの知識を活用して，どのような生物学
的プロセス，分子機能，細胞構成要素，パスウェイ，疾
患，解剖学的部位などと関係がありそうか統計的な手法

を用いたEnrichment解析と呼ばれる機能予測が行われ
る．この結果，実験処理の違いやその有無，フェノタイ
プ（例，正常と疾患サンプル，野生株と変異株）間によ
る分子機序の違いを推測することができる．Enrichment
解析のWebサービス，ツールには，DAVID13)，GSEA14)，
Enrichr15)などがよく知られる．Cytoscapeのアプリには
BiNGO16)などがある．

1-2-1．BiNGO　　【何ができるか？】遺伝子（タン
パク質）リストに対するGene Ontologyを使った機能予
測．解析の結果はGene Ontologyのツリー上で可視化さ
れる．
【入力データ】DEGsのリスト（Entrez Gene IDのリスト．
例，856571，854106，855005，…）など．以下の解析
例では，サンプルデータ117)の“over and under expd 
genes”，“Over-expressed genes”（血栓症および骨髄増
殖性疾患（多血症，本態性血小板血症）の疾患間で共通
に過剰発現した遺伝子群）を使用．
【解析方法】①メインメニューで Apps > BiNGOを選択．
②BiNGO Settingsのウィンドウで，Cluster nameに適
当な名前を入力．③Paste Genes from Textにチェック，
直下の入力スペースにDEGsのリストをコピー&ペース
ト．④少し下にあるOverrepresentationとVisualizationに
チェックを入れ，統計的に有意に関係があると示唆され
る生命現象（例，Gene Ontology term）を可視化するよ
うに設定．⑤下のほうにあるSelect organism/annotation
でHomo sapiensを選択．他の項目は初期設定のまま．⑥
最後に最下部にあるStart BiNGOを押す（図3）．⑦メイ
ンウィンドウに表示された解析結果を確認．必要に応じ
てメインメニュー Layoutでレイアウトを変更する．
サンプルデータ117)を使ったDEGsに対する機能解析
では，mRNA processing (GO:0006397)，immune system 
process (GO:0002376)などの生命現象との関連が示唆さ
れた．

1-3．機能予測結果の可視化　　DEGsの機能予測
（Enrichment解析）によって得られた各生命現象間（例，

図3．BiNGOの設定画面
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Gene Ontology term間）の関係の強さを関係する遺伝子
の重複の程度によってグラフ（ネットワーク）で可視化
する．これにより機能予測結果の理解を深め，データの
解釈を支援する．CytoscapeのアプリClueGO18)では各
生命現象間で共通して関与する遺伝子を比較し，Kappa 
scoreを使ってこれらの一致度を評価する．一致度の大
きさ（生命現象間の関係の強さ）はエッジの太さで表現
さ れ る．EnrichmentMap19)は，DAVID13)，GSEA14)，
BiNGO16)で出力した機能予測の結果を可視化する
Cytoscapeアプリである．

1-3-1．ClueGO　　【何ができるか？】遺伝子（タン
パク質）リストに対する生命現象（GO，KEGGパスウェ
イなど）解析の結果を生命現象間の関係図として可視化．
【入力データ】DEGsのリスト（Entrez Gene IDのリスト．
例，856571，854106，855005，…）など．以下の解析
例では，サンプルデータ220)の“Table 4”（成体マウスの
唾液腺で特異的な遺伝子発現パターンを示した遺伝子
群）を使用．
【解析方法】①メインメニューのAppsでClueGOを選択．
②コントロールパネルのClueGOのタグを選択．③
Load Marker List(s)で，プルダウンメニューからMus 
musculusを選択，下の空欄にDEGsのリスト（Entrez 
Gene   IDなど）をコピー&ペーストする．④ClueGO 
Settingsで利用する解析セットにチェックを入れる（例，
GOのBiologicalProcess）．その他の設定は初期設定の
まま．⑤ClueGO Functional AnalysisのStartボタンを
押す．
サンプルデータ220)を使ったDEGsに対する機能解析
では，regulation of exocytosis (GO:0017157)，protein 
localization to endoplasmic reticulum (GO:0070972)，
Protein export (KEGG:03060)などの生物学的現象，パス
ウェイとの関連が示唆された．さらに，これら各生物学
的現象，パスウェイ間の関係が関与する遺伝子の一致度
に基づいて可視化された．たとえば，protein localization 
to endoplasmic reticulumとProtein export ではその一致

度が高く，両者の関係が強いことが示された（図4）．
2-1．DEGsを含むパスウェイ，ネットワークの作

成　　前述のNetworkAnalyst10)，Cytoscapeのアプリ
stringApp3)，GeneMANIA4)を使い，DEGsの分子間相
互作用情報を外部データベース（例，BioGrid，IntAct，
InnateDB）から収集し，DEGs間もしくはDEGsを含む
パスウェイ，ネットワークを構築する．構築されたパス
ウェイ，ネットワークは，トポロジー解析によるハブ遺
伝子の抽出，機能予測などが行われる．

2-1-1．stringApp　　【何ができるか？】タンパク質
（遺伝子）－タンパク質（遺伝子）間相互作用（PPI）ネッ
トワークの作成．
【入力データ】DEGsのリスト（Entrez Gene IDのリスト．
例，856571，854106，855005，…）など．以下の解析
例では，サンプルデータ117)の“over and under expd 
genes”，“Over-expressed genes”を使用．
【解析方法】①メインメニューのFile > Import > Network 
> Public Databases…を選択．② Import Network from 
Public DatabasesウィンドウのData SourceでSTRING: 
protein queryを選択．③SpeciesでHomo sapiensを選択．
④空欄に697個のDEGsを入力．その他の設定は初期設
定のまま．⑤候補タンパク質が複数あればそれを確認し，
Importボタンを押す．⑥メインネットワークビューに
表示されるネットワーク図を確認．⑦ネットワークを拡
張したい場合は，メインメニューのApps > STRING > 
Expand Networkを選択．⑧Expand Networkのウィン
ドウでNumber of nodes to add to networkで追加するノー
ド（タンパク質）数を入力（例，100）．Relayout 
networkにチェックを入れる．⑨OKを押す．
たとえばサンプルデータ117)では，697個のDEGs か

らそれらを含む789個のPPIネットワークが構築される
（図5）．

2-2．ハブ遺伝子の識別　　ネットワークに対するト
ポロジー解析を行い，ネットワークにおけるノードの重
要性の指標である次数中心性（Degree   Centrality），媒

図4．ClueGOの解析結果
図5．stringAppでネットワークを構築後，NetworkAnalyzer
で中心性を計算した結果．



生物工学　第95巻288

介中心性（Betweenness Centrality）などを求め，パス
ウェイ，ネットワークおけるハブ遺伝子（タンパク質）
を識別する．ハブ遺伝子はさまざまな生命現象のキー遺
伝子となることが推測される．ネットワークのトポロ
ジー解析は，NetworkAnalyst10)，Cytoscapeのアプリ
NetworkAnalyzer7)で実行可能である．

2-2-1．NetworkAnalyzer　　【何ができるか？】ネッ
トワークのトポロジー解析によりネットワークの中心性
を算出．ハブノード（遺伝子，タンパク質）の発見．
【入力データ】PPIネットワークや遺伝子制御ネットワー
ク（GRN），各種パスウェイデータ．以下の解析例では，
前述2-1-1．stringApp3)で作成したPPIネットワークを
使用．
【解析方法】①コントロールパネルのNetworkタブで対
象のネットワークを選択，表示する．②メインメニュー
のTools > NetworkAnalyzer > Network Analysis > 
Analyze Network…を選択．③画面下のテーブルパネル
でNode Tableタブを選択．④Degree（次数：他のノー
ドとの接続数），BetweennessCentrality（媒介中心性：
ノード間の最短経路を基づく中心性の尺度）などのカラ
ムを確認．これらの数値が大きいノードをハブノードと
して評価する．
サンプルデータ117)を使った解析では，UTY (uniprot: 

O14607)，MYC (uniprot:P01106)などで次数や媒介中
心性が大になり，ハブタンパク質の候補になることが明
らかになった（図5）．なお，NetworkAnalyzer7)は，
Cytoscapeの基本ツールとして最初から組み込まれてい
るおり，他のアプリのようにApp Managerからインス
トールする必要はない．

3-1．部分パスウェイの抽出　　パスウェイ，ネッ
トワークからトポロジーや遺伝子発現パターンの
情報を基にして特徴的な部分構造を発見する．前者は，
NetworkAnalyst10)，Cytoscapeの ア プ リMCODE21)，
NetworkAnalyzer7)，後者は，jActiveModules22)などの
ツールが対応する．抽出された部分構造は複合体形成や
生物学的機能との関係が示唆されており 21)，BiNGO16)

やClueGO18)などによるEnrichment解析（機能予測）
が行われる．部分パスウェイの抽出ではないが，
CytoscapeのアプリMCDS6)は，パスウェイ，ネットワー
クから，疾患におけるドライバー遺伝子，GRNおける
マスター遺伝子を見つける解析ツールである．

3-1-1．MCODE　　【何ができるか？】ネットワー
クの中から緊密に結合する部分構造（クラスター，部分
ネットワーク，サブネットワーク）の発見．
【入力データ】PPIネットワークやGRN，各種パスウェ
イデータ．以下の解析例は，サンプルデータ220)の“Table 
4”を使って，stringApp3)によって作成したネットワー
クデータを使用．
【解析方法】①コントロールパネルで対象のネット
ワークを選択，表示する．②メインメニューのApps   > 

MCODE > Open MCODEを選択．③コントロールパネ
ルでMCODEタブを選択．Find Clustersで in whole 
networkを選択し，解析の範囲をネットワーク全体に指
定．④Advanced Optionは初期設定のまま．⑤Analyze 
Current Networkを押す．⑥画面右に表示されるResults 
PanelでMCODEタブを選択．⑦クラスターがリストアッ
プされているので，マウスで選択．メインメニューのネッ
トワーク上でクラスターを確認（図6）．⑧クラスター
に対して，BiNGO16)やClueGO18)などを用い機能予測
を行う．
サンプルデータ220)を使った解析では，複合体形成が
示唆されるUbc，Rps27aなど35個の遺伝子から構成さ
れるクラスターの他全部で12種類のクラスターが発見
された．

3-1-2．MCDS　　【何ができるか？】ネットワーク
分析によるPPIネットワークやGRNからドライバー遺
伝子やマスター遺伝子の発見．
【入力データ】PPIネットワークやGRN．以下の解析例
では，サンプルデータ323) （シロイヌナズナ種子の休眠
期および発芽時の遺伝子共発現ネットワーク）を使用．
【解析方法】①メインメニューのFile > Openでサンプル
データ323)を開く．②メインメニューで，Apps > MCDS 
>   Startを選択．③コントロールパネルでMCDSタブを
選択．④サンプルデータ323)のように無向ネットワーク
（例，PPIネットワーク）ならば，Optimization criterion
で largest connected component (undirected)を選択．も
し対象ネットワークが有向ネットワーク（例，GRN）
ならば，largest connected component (directed)を選択．
⑤Run   MCDSを押す．⑥ドライバー遺伝子やマスター
遺伝子の候補となるdominatorやconnector（ノード）
がコントロールパネルのMCDSタブにMCDS   resultと
して表示される．
サンプルデータ323)を用いた解析では，471個の遺伝
子ネットワークからAt1g09780 (iPGAM1)など93個の
候補遺伝子が見つかった（図7）．
ここでこれまでに紹介した解析とその対応ツール，

図6．MCODEの解析結果
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Cytoscapeアプリを表1にまとめる．

最後に

Cytoscapeおよびそのアプリを活用した研究成果を紹
介するSNSであるCytoscape Publication24)によると，
ここ数年増えてきたデータ駆動型アプローチの研究や公
共データベースを再解析した研究，複数の研究成果を統
合して解析する（メタ解析）の研究においても
Cytoscapeが多数活用されていることが分かる．実際，
本稿の解析例で用いたサンプルデータ117)，220)は，デー
タの再解析やメタ解析によって得られたものである．ま
た，他のツール（例，NetworkAnalyst10)，GSEA14)）で
解析した結果の可視化や再解析にCytoscapeが活用さ
れ，データの理解を深め，解釈の妥当性や信頼性を保証
することに貢献する例も見られる．Cytoscapeがオープ
ンプラットフォームであること，大規模データに対応し
ていること，アプリによって最先端の解析アルゴリズム

が実装されることを考えると，Cytoscapeの活用の機会
は今後も増え続けることが予想される．
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表1．各種解析と代表的な対応ツール，アプリ

解析の種類 対応するツール，Cytoscapeアプリ*

DEGsの抽出 NetworkAnalyst10), R11,12)

機能予測 DAVID13), GSEA14), Enrichr15)

BiNGO*16)

機能予測結果の可視化 ClueGO*18), EnrichmentMap*19)

ネットワークの作成 NetworkAnalyst10), stringApp*3)

GeneMANIA*4), WikiPathways*5)

ハブ遺伝子の識別 NetworkAnalyst10), 
NetworkAnalyzer*7)

部分パスウェイの抽出 NetworkAnalyst10), MCODE*21)

NetworkAnalyzer*7)

jActiveModules*22)

ドライバー遺伝子の発見 MCDS6)

図7．MCDSの設定と解析結果


